Lab Guide

Group Policy Management



Implementing Group Policy Object

1. Group Policy can be used for various tasks, lets try first with a simple Setting to hide the clock from the taskbar
From Server Manager, click on Tools, and select “Group Policy Management”
R-click on the target OU, and click Create a GPO in this domain and link it here...

5. Group Policy Management — O *
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5L File Action View Window Help
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|2 Group Policy Management IT

v &\ Forest LAB.LOCAL
v (4 Domains

~ 3 LAB.LOCAL Link Order GPO Enforced Link Enabled
i/ Default Domain Policy
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il Egypt
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3| Sa | Create a GPO in this domain, and Link it here... |

5 G Link an Existing GPO...

Linked Group Policy Objects  Group Policy Inhertance  Delegation

Block Inheritance
i Sites Group Policy Update...
5% Group Po Group Policy Modeling Wizard...
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& rotp Fo Mew Organizational Unit

View »
Mew Window from Here
Delete

Rename
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2. The wizard will ask for a New GPO name, give it a name and click Ok

Mew GPO x
Mame:
|Hide Clock from task bar
Source Starter GPO:
{none) w
Cancel
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3. Now the GPO is created and we need to open it in the editor, and change the required setting, r-click on the

GPO and select Edit..

Open the GPO editor

=, Group Policy Management — *
'zl File Action View Window Help 8 x
= | #n@ 0(XE & HE
(L, Group Policy Management IT
h —ﬁ F?rest: LAB.LOCAL Linked Group Policy Objects | Group Policy Inheritance  Delegation
v g5 Domains -
w _i:J LAB.LOCAL Link: Order GPO Enforced Link Enabled
i/ Default Domain Policy 1 i/ Hide Clock fromtas...  No Yes
= | Domain Controllers
5 Egypt
v Z1 1T
i/ Hide Clock fram task bar
5} Group Policy Objects Enforced
5 WM Filters
= ~  Link Enabled
[5]| Starter GPOs Ik Enable
B Sites Save Report...
st Group Policy Modeling Mew Window from Here
"+ Group Policy Results
Delete
Rename
Refresh
Help
H | < >

4. Now with the editor opened, we navigate to the target setting, as shown in the figure below, r-click on the

setting and select Edit, or you can just double click on it.

%[ Group Policy Management Editor

File Action View Help

e | pEzHE 7

w i Computer Configuration
| Policies
| Preferences

=

v 4%, User Configuration '_;'
w || Policies '—:‘
| Software Settings L=l

| Windows Settings El
~ [] Administrative Templates: Poli|| 5=
| Control Panel |
| Desktop =]
s [ Metwork =]
| Shared Folders =]
jIStart Menu and Taskbar I i
| System
| Windows Components
= All Settings
" Preferences

=

=| Rerove programs on Settings menu

=] Remove Videos link from Start Menu

'=[ Hide Clock from task bar [DC1.LAB.LOCA Setting State

Remave Search Computer link Mot configured

Remove See More Results / Search Everywhere link Mot configured
Do not search for files Mot configured
Do not search Internet Mot configured
Do not search programs and Centrol Panel iterns Mot configured
Mot configured

Prevent changes to Taskbar and Start Menu Settings Mot configured

Remove Downleads link from Start Menu Mot configured
Remove Homegroup link from Start Menu Mot configured
Remove Recorded TV link from Start Menu Mot configured

Remave user's folders from the Start Menu Mot configured
Mot configured

Ferce classic Start Menu

Mot configured

emove Clock frem the system notification area Mot configured

Prevent grouping of taskbar items configured
Do not display any custom toolbars Filter On configured
Remove access to the context menu Filter Options... configured
Hide the notification area . ) configured
. . Re-Apply Filter )
Prevent users from uninstalling appl N configured
Remaove user folder link from Start All Tasks » configured
Rernawve user name from Start Menu confioured

Help

£ >

Extended )\Standard/

Edit Administrative Templates policy setting
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5. In the setting windows, you will find an explanation on what exactly it does, click on Enabled, and click Ok

A Remove Clock from the systemn notification area O x

E} Rermove Clock from the system notification area

Previous Setting Mext Setting
(O Not Configured ~ Comment:
(®) Enabled
() Disabled
Supperted o | At jeast Windows Server 2003 operating systems or Windows XP Professional
Cpticns: Help:

Prevents the clock in the system notification area from being
displayed.

If you enable this setting, the clock will not be displayed in the
system notification area,

If you disable or do not configure this setting, the default
behavior of the clock appearing in the notification area will
occur.

oK |I Cancel Apply

6. The setting is now changed, just close the editor and update the group policy on the client machine using the
command gpupdate /force in CMD as show below:

EM Administrator: CA\Windows\system32\cmd.exe

C:\Users\Administrator>gpupdate /force
Updating Policy...

User Policy update has completed successfully.

Computer Policy update has completed successfully.

C:\Users\Administrator:

The client machine will update the policy eventually as it asks the domain controller for updates every 90 : 120
minutes, but in a lab environment we use the command as we don’t have to wait.
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7. If you r-click on the GPO and clear the selection on Link Enabled option, it means the GPO link is still there
but the GPO is not applied, you could use this option to temporary disable the GPO.

3 Group Policy Management - O X
p oy g
= File Action View Window Hel -5 =
2 p
o= 2F X4
& Group Policy Management Hide Clock from task bar
v 4\ Forest: LABLOCAL Scope Detalls Settings Delegation
w g5 Domains .
v 3 LAB.LOCAL Links
1] Default Domain Policy Display links in this location: LAB LOCAL v
=1 Domain Controllers The following sites, domaing, and OlUs are linked to this GPO:
2] Egypt A
v BT Location Enforced Link Enabled Patl
-/ Hide Clock from task bar BT Mo Mo LAE
2| Sales Edit...
3; Group Policy Objects Enfareed Ed '
E WMI Filters Lnk Enabled
L] Starter GPOs
B Sites Save Report... aly to the following groups, users, and computers:
58 Group Policy Modeling YFzr 3 .
&, Group Policy Results '
= Mew Window from Here
Delete
Rename ove Properties
Refresh .
Help WM fiter:
Toggle the Link Enabled attribute for this link

8. Now we create another GPO, with the name “Deny Access to Control Panel” and link it to the whole domain
“Lab.local”. This setting will restrict access to Control Panel

%[ Group Policy Management Editor - O X
File Action View Help

= 2H= HEl 7

(5[ Deny access to control panel [DC1.LAB.L Setting

State Coi
v (E.Dr;prlt,er Configuration | Add or Remove Programs
?‘ oheEs | Display
| Preferences = -
. . _| Personalization
w ﬁ‘_i) User Configuration .
= .. | Printers
w || Policies —
| Software Settings \J Programs .
= Windows Settings | R?glonal aln.d Language Optmlns .
v [7] Administrative Templates: Pol \iz| Hide specified Control Panel items Mot configured
| Control Panel Mot conf d

|| Desktop
] Metwork
| Shared Folders
| Start Menu and Taskbar
| System
| Windows Components
T All Settings
| Preferences

|iz] Show only specified Control Panel items Mot configured

<

< > | Extended } Standard /
4 setting(s)
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9. By inheritance the GPOs linked to the domain apply to all OUs.
You can stop the inheritance on a specific OU, this means you will apply only special GPOs explicitly on that
OU, to disable the inheritance, r-click on the OU and select Block Inheritance

15 Group Policy Management — O
5L File Action View Window Help - &
= am B|XE G HE
5L, Group Policy Management IT
e 5\—\' F?rest: LA_B'LOCAL Linked Group Policy Objects  Group Policy Inheritance  Delegation

w |55 Domains -

w 3 LAB.LOCAL Link Crder GPO Erforced Link Enabled
iz Default Domain Policy 1 5/ Hide Clock fromtas... Mo Yes
=/ Deny access to control panel
2| Domain Controllers
2l Egypt
3] 1T
2l 5a Create a GPQ in this domain, and Link it here...
= 67 Linkan Existing GPO...

=4 w Block Inheritance
Ll Sti -

i Sites Group Policy Update...

i Group Po Group Policy Modeling Wizard...

& G P

&g broup o Mew Crganizational Unit

View *
MNew Window from Here
Delete
Rename o
Refresh
Teggle block inherita rmzis

10. Now as requirements can change, it came up that there are no exceptions from “Deny access to control panel”
policy to anyone, so we enable the Enforced option for the GPO, and it will go through any level with blocked
inheritance on any OU below in the hierarchy. (it will put a small lock on the GPO icon)

2 Group Policy Management - O >
p ¥ g

1zl File Action View Window Help

e 2m X G|

|5, Group Policy Management Deny access to control panel
A 5\_\ F'?rESt: LA_E'LOCAL Scope  [Detals Settings Delegation
w |4 Domains
Links

v #3 LABLOCAL s
ii Default Domain Policy Display links in this location: LAB.LOCAL v

Deny access to control panel The frllwing stes Anmaine and OUs are linked to this GPO:
o | Domain Controllers Edit...
:_ Egypt \F:nforced \Ll{nk Enabled E:’[EI
« g lT = es es
+  Link Enabled
@i Hide Clock from task be i Enable
= Sales Save Report... v
_=J Group Policy Objects iz N !
& WMI Filters )
Em Starter GPO< MNew Window from Here aphy to the following groups, users, and computers:
@ Sites Delete
s Group Policy Medeling Rename
| Group Policy Results
- Refresh
Help nove Properties
]
WMI Filtering

This GPOQ is linked to the following WM filter:

D, . e

Toggle the Enforced attribute for this link
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11. Security filtering enable you to disable the GPO for any object without having to remove it from the OU.
Click on the GPO to select it, then open the Delegation tab, and click on Advanced

& Group Policy Management — O d
5L File Action View Window Help - 8 %
= a5 ¢
|5 Group Policy Management Hide Clock from task bar
hd —'_L\ F?rest: LA_B'LOCAL Scope Detailz  Settings

w |5 Domains
& fs] LAB.LOCAL These groups and users have the specified pemission for this GPO
i/ Default Domain Policy Groups and users:
i Deny access to control panel Name Allowed Pemissions
21 Domain Controllers 82, Authenticated Users Read firom Securty Fite
' :U Egypt i"ie_l Domain Adming (LABDomain Admins) Edit settings, delete, moc
v plT i"ig_l Enterprise Admins (LAB"\Enterprise Admins) Edit settings, delete, moc
p/ Hide Clock from task bar | 2, ENTERPRISE DOMAIN CONTROLLERS Read
(2] Sales 82, SYSTEM Edit settings, delete, mac
[ 5} Group Pelicy Objects
[ WMI Filters
ﬂ Starter GPOs
& Sites

s&f Group Paolicy Modeling
', Group Palicy Results

< >

Add... Remove Properties Advanced... I

12. This will open the ACL to edit the permission for the GPO, click in Add

Hide Clock from task bar Security Settings >

Security

GI’CILII'.‘I Or User names:

B2 CREATOR OWNER ~
SR Autherticated Users

HE SYSTEM

SR Domain Admins (LAE\Domain Admins)

SR Enterprize Admins (LAB Erterprise Admins) R4
£ >

Pemissions for CREATOR

OWNER Allow

Full cortrol

Read

Write

Create all child objects
Delete all child objects

DDDDDE‘

oooog

For special permissions or advanced settings, T —
click Advanced.

QK Cancel Apphy
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13. Type in the username and click Check Names to confirm it, then click Ok, this will add the user to the ACL

Select Users, Computers, Service Accounts, or Groups >
Select this object type:

|U5&1’S. Groups, or Builtin security principals | Object Types...
From this location:

[LAB LOCAL || Locations...
Erter the object names to select (eamples):

Mz (Max@LAB.LOCAL) Check Names

Advanced... Cancel

14. Now with the user account selected, put a check to Deny “Read” and “Apply group policy” permissions.
In the warning click Yes, it just confirms on you the Deny overrides any other permission.
Now after the client update the policy, “Max” will find out that this specific GPO doesn’t apply on him.

Hide Clock from task bar Security Settings *

Security

GI’DLII'.‘I Qr user names:

2 Domain Admins {LAB\Domain Admins) ~
52 Enterprise Admins (LABErterprise Admins)
SR ENTERPRISE DOMAIN CONTROLLERS
F Max (Max@LAB. LOCAL)

W
< >
Add... Remove
Pemissions for Max Allow Dery
Read ] =1
Write ] ]
Create all child objects ] ]
Delete all child objects ] ]
Apply group policy L] (=

For special pemmissions or advanced settings.
click Advanced.

Corcal | [ oot
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15. If you want to apply a WMI filter for GPO, go to WMI Filters, r-click and select New...

5L Group Policy Management
5L File Action View Window Help
LI AR 1ol N =NNENN ? Ho:

|54 Group Policy Management WMI Filters in LAB.LOCAL
v £h Forest LAB.LOCAL Conterts | Delegation
w |5 Domains -
W -}F'j LAB.LOCAL Name Description Linked GPO

= Default Domain Policy
=/ Deny access to centrol panel
» |2 Domain Cantrollers
» [2] Egypt
v g T
i Hide Clock from task bar
» 2] Sales

s [ =} Group Policy Objects
I = WMI Filters i
» (] Starter GPt I MNew... I

> _Erg Sites . Import..
s Group Policy Moc
|4, Group Policy Rest View 4

Mew Window from Here
Refresh

Help

1=

Create a new WMI filter

16. In the New WMI Filter window, type a name and description if you will, and click Add
We will add a filter to select only machines that run Windows 10

Mew WM Filter >
Mame:

Windows 10

Description:

Select Windows 10 machines
Gueries:

M amezpace | Query |

Remove
Edit
Save Cancel
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17. In the WMI Query window type in the query “select * from Win32_OperatingSystem where Version like

""10.%"" and click Ok
WMI Cuery x
MNamespace:
|mnﬂCII‘v11.r2 Bl
Queny:
|se|ect *from Win32_Operating System where Version like "10.%"
G
18. In the New WMI Filter window, click Save
Mew WM Filter >
MName:
|Windnws 10 |
Description:
|Seleu:'t Windows 10 machines |
Queres:
MNamespace | ey Add
roathClk v zelect ™ from “Win3Z2_OperatingSystem where
Verzion like "10.%" —
Edit
e ]| | oo
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19. Now we apply the filter to a GPO, select the required GPO, and select the filter as shown in the figure below:

|2, Group Policy Management - O x
2 File Action View Window Help -8 %
ol ANalies (MR 7
|5, Group Policy Management Hide Clock from task bar
e —\ﬁ" quest: LA_B'LOCAL Scope  Detals  Settings Delegation

v |55 Domains .
v 33 LABLOCAL Links
] Default Damain Policy Display links in this location: LAB.LOCAL -
E?J Deny access to control panel The following sites, domains, and OUs are linked to this GPO:
> 2] Domain Controllers =
s 51 Egypt Location Enforced Link Enabled Path
v @I @I No Yes LAB.LOCA
=/ Hide Clock from task bar |
5 2] Sales < >
» [ Group Policy Objects §
v [ WMI Filters Security Filtering
] F Windows 10 The settings in this GPO can only apply to the following groups, users, and computers:
» [ ] Starter GPOs =
» L& Sites Name
st Group Policy Modeling 82 Authenticated Users
[ 4, Group Policy Results
Add... Remove Properties
|
WMI Filtering
This GPQ is linked to the following WMI fiter:
<nones ~ COpen

20. In the confirmation window click Yes

Group Policy Management

o Would you like to change the WM filter to Windows 10

Yes Mo

Now this policy will apply only the Windows 10 machines in the target OU as the filter is configured.
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Use GPO to install software

1. First, the software must be shared in a folder for everyone with a read permission.
2. Create a GPO and link it to the target OU, then r-click on it and select edit to open the editor, select the option
to add a New Package in the path shown in the figure below:

\=[ Group Policy Management Editor — a *
File Action View Help
= 2@ EGC=Hm

=] Install Winzip [DC1.LAB.LOCAL] Pelicy Mame Version Deployment st.. Source
v il Computer Configuration
w || Policies There are no items to show in this view,

w [ | Software Settings
Software installation
» [ Windows Settings Mew > Package...
| Administrative Templz

. Vi >
| Preferences 1=
~ 4®, User Cenfiguration Paste
‘__| Palicies Refresh
| Preferences )
Export List...
Properties
Help
< >

Adds a package.

3. Inthe open window, you must type the UNC path for the network share for the software to be installed

= Open x

1 s Metwork » del » SW v 0 Search SW o

Organize « Mew folder =~ [ @

= [ on HOQ ~ Mame Date modified Type

I Desktop 5 winzip_en_64.msi 12/27/201711:13 .. Windows

AL

Documents
Downloads
Music

Pictures

Videos

Local Disk ()
DVD Drive (D) 5!
homes (hdel)

H BYFEMNYS @@

|_j' Metwork

v £ >

File name |‘-J-‘dc‘|‘-‘sw{ v| Windows Installer packages (*.r ~

o ] cone
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4. In the Deploy Software windows click Ok

Deploy Software >

Select deployment method:
Published
(@) Assigned
() Advanced

Select this option to Assign the application without modifications.

Cancel

5. Wait moments for the file to be loaded and you will see the following window, close the window, and go to the
client to update the policy, it will ask for a restart and the software will be installed after the restart.

\=f Group Policy Managerent Editor — O =
File Action View Help
Lol AR N (IERENEYN * B
_%J' Install Winzip [DC1.LAB.LOCAL] Policy Mame Version Deployment st...  Source
v {8 Computer Configuration Bl Winzip 21.5 215 Assigned \WdeT\SWiwinzip_en_64.msi
w || Policies
w [ | Software Settings
Software installation
| Windows Settings
| Administrative Templates: Policy de
| Preferences
~ ¥, User Configuration
| Policies
| Preferences
< >« >
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Software restriction using GPO

1. Get the executable file for that software you would like to restrict access to. | will use the .exe file to Solitaire,
that is installed on Windows 7
2. Create a GPO for the target OU as usual, open the editor, go to the setting shown in the figure below:

' Group Policy Management Editor - O x
File Action View Help
= =
~ (& Computer Configuration A

v [ P_olicies } |'-§ Mo Software Restriction Policies Defined
| Software Settings ==

wv [ Windows Settings

Seftware restriction policies are not defined in this Group Policy object. If you

=l Name Resolution Palicy define software restriction policies in this Group Policy object, they will override
=] Seripts (Startup/Shutdown) inherited policy settings from other Group Policy objects.
= Deployed Printers
i i,l Security Settings To define software restriction policies, in the Action menu, click New Software

Ed Account Policies Restriction Policies,

'itd Local Policies Note: After initially creating software restriction policies, a reboot is required
i Eventlog before they will be enforced.
‘7 Restricted Groups
‘i Systemn Services
‘i Registry
" File System
F1 Wired Network (IEEE 802.3) Po
| Windows Firewall with Advan:
| Metwork List Manager Policies
;_jj‘ Wireless Metwork (IEEE 802.11]
| Public Key Policies
| | Software Restriction Pelicies |
| Application Control Policie: I New Software Restriction Policies I
,g IP Security Policies on Activ

| Advanced Audit Policy Con All Tasks 5
< | o View 5
Creates software restriction policies for this Group Help

3. Double click on the Additional Rules folder

=/ Group Policy Management Editor - O >
File Action View Help
X AR (N =NN-NENN 7 o

~ i Computer Configuration # || Object Type
~ [ | Policies .
| Software Settings
~ [ Windows Settings
| Mame Resolution Policy
=i Scripts (Startup/Shutdown)
= Deployed Printers
v f‘_;l Security Settings
_Ea Account Policies
| Local Policies
‘.ﬁ Event Log
5 Restricted Groups
5 System Services
5 Registry
5 File System
Eof Wired Network (IEEE 802.3) Po
1 Windows Firewall with Advarn
| Network List Manager Policies
ﬂﬂ Wireless Network (IEEE 802.11;
| Public Key Policies
| Software Restriction Policies
| Application Contrel Policies
g IP Security Policies on Active [
| Advanced Audit Policy Config ,,

Enforcement
,'{i,'g: Designated File Types
E@,'gtTrusted Publishers

£ >
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4. R-click in the free space inside and select New Hash Rule...

'=[ Group Policy Management Editor
File Action View Help

s 2E E d=2HE

v (M Computer Configuration A || Mame Type
M E?";'Tm et 5 %HKEY_LOCAL MACHINE\SOFTWARE... Path
L1 Software Settings 5 %HKEY_LOCAL_MACHINE\SOFTWARE,... Path

w || Windows Settings
1 Name Resolution Policy
| Scripts (Startup/Shutdown) Mew Certificate Rule...

= Deployed Printers I Mew Hash Rule I
v f‘_:_.l Security Settings
__:fa Account Policies

Mew Metwork Zone Rule...

iﬂ Local Policies MNew Path Rule...
dl EventLog Al Tasks

|z Restricted Groups

[[4, System Services Refresh

(8 Registry Export List...

|_a File System

_::Ej' Wired Metwork (IEEE 802.3) Po Yiew

] Windows Firewall with Advan
[ Metwork List Manager Policies
aj Wireless Metwork (IEEE 802,117
_‘:| Public Key Policies Help
~ || Software Restriction Policies

[ 1 Security Levels

| Additional Rules
Z‘l Applicatlion_C?n.trol P‘D-Iici.es o

Arrange lcons

Line up lcons

< > <

Security Level

Unrestricted
Unrestricted

Descriptic

Adds a new application hash rule,

5. In the New Hash Rule window click Browse

Mew Hash Rule x
General
f:S lUse rules to ovemde the default securty level.

%P_'J Click Browse to select the file you want to hash. The file's
attributes, such as its size and the date and time it was created,
are automatically populated.

Browse. ..

File information:

Security level: Disallowed t

Description:

QK Cancel Apply
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6. Select the .exe file and click open

[ Open

Organize = Mew folder

A L0y Network » del » SW

= [ onHQ 2 Mame

; Downloads

J'ﬁ Music

&=/ Pictures

E Videos

= Local Disk (C:)
8 DVD Drive (D7) 5
== homes (\dcl) (0

|_ﬂ' Metwork
WL

File name:

I Desktop 2| Solitaire.exe
Documents winzip_en_&4.msi

v | D

Solitaire.exe

S

Search SW 2

=~ M @
Date modified Type

7/13/2009 6:39 PM Applicati

12/272M7 1113 .. Windows

All Files (*.%) ~

Open Cancel

7. Notice that the default Security level is Disallowed, click Ok to close the window.

Mew Hazh Rule

General

Use rules to ovemde the default security level.

14
%.“‘.'I Click Browse to select the file you want to hash. The file’s
attributes, such as its size and the date and time it was created,

are automatically populated.

File information:

ped

Browse. ..

solitaire exe

solitaire.exe (6.1.7600.16385)

Executable for Soltaire Game
Microsoft® Windows® QOperating System

Security level:

Description:

Digallowed

oK

Cancel

Apply
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